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Purpose

The purpose of this exercise is to introduce the use of GIS in groundwater studies.  The users will perform basic groundwater tasks such as viewing aquifers and well locations, creating a potentiometric surface for the Edwards aquifer, and using the groundwater analysis tools in ArcGIS. Users will also be introduced to digital Hydrogeologic resources. The second part of the exercise will introduce the Arc Hydro groundwater tools, developed at CRWR. In this part users will construct 3D models of the subsurface within ArcScene and visualize subsurface information. 
Computer and Data Requirements
To carry out this exercise, you need to have a computer, which runs the ArcInfo version of ArcGIS. The data are provided at, http://www.ce.utexas.edu/prof/maidment/giswr2004/ex6/ex62004.zip.   
They can also be obtained in the LRC in /civil/class/maidment/giswr2004/ex6.  

Data location and description: 

After unzipping the data you will see the following folders and datasets: 
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· Ex6DLLs: contains the DLLs you will use in the exercise. Copy the files esriGWAnalysis.dll and GroundwaterToolbarNew.dll into C:\Program files\ArcGIS\Bin. 
· GWAnalysis: contains rasters used with the groundwater analysis tools in ArcMap.
· Q: contains files used by QHull (a computational geometry program).
· Rasters: The DEM of the San Marcos River basin.

· Ex6GW: A geodatabase containing hydrogeologic information for the Edwards aquifer. The geodatabase contains two feature datasets: GeoMap for national and state coverages of the geology, aquifers, and soils. And Hydrogeology for hydrogeologic data in the Edwards aquifer area.
· Statsgo: contains the Statsgo soil datasets for Texas.

Exploring Geologic and Hydrogeologic data
This part of the exercise will introduce you to some national geologic and hydrogeologic datasets. You will also create a geologic formations and soils map for the Guadalupe river basin by extracting information from the national and state datasets.
In Exercise 2 in this course, we built a basemap of the Guadalupe Basin and towards the end we added a map of the Edwards aquifer and examined how the presence of the aquifer underlying the Guadalupe River actually adds flow to the river through the discharge of groundwater to the river system.   In Exercises 3-5 we focused in more closely on the San Marcos subbasin of the Guadalupe, and looked at the time variations of rainfall and flow from the surface and groundwater systems, in particular from San Marcos Springs.   In this exercise, we are going to explore more thoroughly the aquifers and hydrogeology of the Edwards Aquifer.  
Open Arc Map and from the Ex6GW geodatabase and Hydrogeology feature dataset, add the themes Waterline, Edwards, SanMarcosBasin and GuadalupeBasin.   Symbolize the Edwards feature class using its Aquifer attribute, whose values mean 0 = no aquifer, 1 = outcrop, 2 = downdip.  The outcrop is where the aquifer is exposed at the land surface while the downdip area is where the aquifer slopes downward below the land surface.   Save the map document as Edwards.mxd.  
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Geology

Hydrogeology is the study of the movement of water through geologic structures.  Lets get a sense of the geological context of the Edwards aquifer.
Load the GeoArea, and GeoLine, feature classes from the GeoMap feature dataset. The GeoArea and GeoLine feature classes represent geologic formations and faults as commonly described in geologic maps, and the third feature class shows the major aquifers of the US. You can categorize the GeoArea features based on the ROCKDESC (Rock Description) field to display the types of geologic formations.  These geological data are drawn from a 1:2,000,000 scale map of the geology of the United States which was obtained from Dr Randy Keller of Dept of Geological Sciences, UT El Paso.  If you make the symbolization of the Edwards aquifer and Guadalupe Basin hollow, you’ll get a display something like that below.   The Geoline feature class represents faults in the geologic structures.    Notice how fractured is the geology that underlies the Edwards aquifer.
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The Edwards Aquifer was formed by many processes that occurred over a long period of geologic history.   The main deposition of the Edwards limestone occurred during the Cretaceous period of the Mesozoic era, about 100 million years ago.
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http://www.edwardsaquifer.net/geology.html
Lets build a geologic map for the Guadalupe river basin.  Open ArcToolbox and locate the Clip tool (under Analysis > Extract). In the tool’s window select the GeoArea as the input features and the GuadalupeBasin as the clip features as shown below.
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Click OK. A new layer should be added to the map named GeoArea_Clip1. Change the symbology of the layer to show the rock types (use the ROCKDESC field) as shown in the following figure, and use the ROCKDESC as the Label field so as to show the different rock types underlying the Guadalupe Basin
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To be turned in:  A geologic map of the Guadalupe basin.  

If you compare the names of the rock formations in the Edwards geologic map with those in the geologic time scale shown below, you can see that the youngest formations (Holocene) are near the coast while as you go inland, the formations become progressively older (Pleistocene, Pliocene, Miocene, Eocene, Paleocene…).   Beginning in the Jurassic period of the Mesozoic era, about 200 million years ago, all this area of Texas lay under the sea.
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http://www.geo.ucalgary.ca/~macrae/timescale/timescale.html
Soils

Load the Statsgo feature class from the GeoMap feature dataset. Create a soils map for the Guadalupe basin as you did with the geologic formations (using the clip tool). The spatial data is related to set of lookup tables stored in the Statsgo folder. A description of the map units is contained in the MAPUNIT table, and linked to the spatial data through the MUID field. The MAPUNIT table can then be linked to a set lookup tables which contain up to 60 properties and up to 6 layers. For more information about the lookup table structure see the Statsgo manual in the Statsgo folder or online at: http://www.ncgc.nrcs.usda.gov/branch/ssb/products/statsgo/index.html.   The COMP and LAYER tables are the critical ones to access if you want to know more about soil properties.  For more information on Statsgo, see http://www.ce.utexas.edu/prof/maidment/giswr98/statland/webfiles/viewstat.htm Its clear that the spatial pattern of the soil map closely follows the underlying geology map, which is logical since soils are formed from weathered rocks.   However fluvial processes also play a role in soil development.  Highlight the soil in MUID = TX326, shown in blue here.  This is an alluvial soil that has been developed through the action of the Guadalupe River eroding the underlying geology and depositing the eroded materials downstream.   You can see the association between the alluvial soil types and the stream network that helped to create them.
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To be turned in:  Make a soil map of the Guadalupe basin  Pick a particular soil map unit and identify the rock type or types which underly it.
Groundwater Analysis 
Creating a potentiometric surface for the Edwards aquifer:

In this part of the exercise you will create a potentiometric surface for the Edwards aquifer by interpolating water levels recorded at wells. You will then compare the potentiometric surface to a digital elevation model to try and find areas of potential discharge from the Edwards aquifer. You will then use the ArcGIS groundwater analysis tools.  The Well data were drawn from the Texas Water Development Board’s website.
Open a new map dislay in ArcMap. Load the Well and the EdwardsSouth feature classes from the Hydrogeology feature dataset. Display the wells by the FType field to view the types of wells that exist in the data. There are 3 types of wells: Water wells (irrigation, monitoring, water supply etc. FType = 1), stratigraphy wells (FType = 2), and springs (FType = 3). Create a map of the Edwards aquifers and a display of the well types on the map. You can use the definition query in the layers properties to display and interact with specific types of information. For example, to show only the water wells right click on the Well layer and select the Properties command. In the properties window select the Definition Query tab and use the Query Builder to view only water wells (FType = 1). 
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The following figure shows the water wells in the well feature class. 
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Open the attribute table of the Well layer, you will see that only the wells with FType = 1 are in the attribute table. 
You will use the water wells to create a potentiometric surface for the south portion of the Edwards aquifer. After applying the definition query open the attribute table and view the fields in the feature class. 
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The field WaterLevel_m represents the potentiometric surface at a specific time (July 2001); the values are in meters above mean sea level. We will use this field to create the potentiometric surface. 

Add the Spatial analyst toolbar to the map by selecting Tools > Customize > toolbars and select the Spatial Analyst toolbar. Once the toolbar is loaded select the Options button to define how the interpolation will be preformed. 
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For Analysis mask select the Edwards south layer, this defines in what area the interpolation will be applied. For Extent also select the Edwards South layer, and for Cell Size select 250 meters.
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Click Ok; this will bring you back to the map. From the Spatial Analyst toolbar select the Interpolate to Raster command, and select the Inverse Distance Weighted option. Select the Well layer as the input points and the WaterLevel_m as the Z value field. Save the resulting raster as PiezoHead in the Rasters folder of your dataset
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You can now display the piezometric head surface and change its symbology; you can use the Stretched option to display the piezometric surface. Add the Spring features from the Hydrogeology feature dataset.   These are the Comal and San Marcos Springs.   Use the Measure Distance tool [image: image18.png]


 to estimate the flow distance from the western end of the aquifer to Comal Springs, and by querying the piezometric head surface, at each end of the line, estimate the gradient of the piezometric head surface 
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Water flows in the Edwards aquifer from the West to the East and North, as shown below (in contrast to the stream network whose flow is transverse to the direction of the aquifer flow.
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http://www.edwardsaquifer.net/geology.html
To be turned in: a map showing the piezometric surface together with the spring features.  What is the gradient of the piezometric head surface in the Edwards aquifer from the western end of the aquifer to Comal Springs?
Comparing the piezometric surface with the DEM:
In this section you will compare the interpolated potentiometric surface with the DEM of the San Marcos basin to see the location of potential discharge areas from the aquifer. Load the DEM smdemproj from the Rasters folder, also load the feature class WaterLine from the Hydrogeology feature dataset (shows the river network within the Guadalupe river basin). The rasters should overlap as shown in the following figure.   You can use the Layer/Display properties to make the DEM layer 50% transparent so that you can still see the aquifer beneath.
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We will use Raster Calculator to create a new raster representing the difference between the piezometric head surface and the DEM. In Spatial Analyst toolbar select Options. For the Analysis Mask and Extent select the Edwards South layer, and select a 250 meter grid cell size as shown below.
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Select Raster Calculator in Spatial Analyst. Build an expression that will deduct the DEM value from the potentiometric surface as shown below. 
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Click Evaluate. A new raster named Calculation should be created. Select the Calculation layer, Right Click and select the Make Permanent command. Give it a name, say PiezoDepth and save the raster to the Rasters folder. The extent of the raster is the intersection between the two input rasters.  Notice the rather nice pattern in the map you’ve created.  If you click around on the Piezometric Depth raster, you’ll see how it gets shallow near the streams and deeper away from them and up-gradient in the flow field.
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Lets do another calculation to find out where the piezometric head surface actually is above the land surface.  Add the PiezoDepth raster to the map display and using the Raster Calculator, find the zones where PiezoDepth > 0 (i.e. where PiezoHead > DEM elevation).
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If you zoom in, you’ll find that the areas are identified are just in the areas of the Comal and San Marcos Springs and nowhere else.   Ok!  Groundwater hydraulics works!  Springs appear where the pressure of the upgradient water is sufficiently high that the piezometric head surface is above the land surface.  Pretty cool!
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To be turned in: A map showing potential discharge zones (where the piezometric surface is higher than the digital elevation model). Display the springs in the Springs feature class on top of the discharge areas.
ESRI has some groundwater tools that enable you to do flow calculations and particle tracking in ArcMap.  In the interests of trimming the length of this exercise, these are contained in the attachment ESRIGWTools.doc that you can work through if you are really interested in groundwater.
Introduction to ArcScene and applying the Arc Hydro groundwater tools

This part of the exercise will introduce you to ArcScene, the 3D visualization component of ArcGIS. You will also get familiar with the Arc Hydro groundwater tools developed at CRWR. 

A few tips for working in ArcScene:

1. Save the Arc Scene document frequently, the application takes a lot of processing power and crashes more frequently then Arc Map.
2. Sometimes layers in ArcScene do not refresh and don’t show in the scene view. You can refresh a layer by selecting the layer in the content window > Right Clicking > Refresh.
3. If the refresh doesn’t help you can try closing the document and reopening, or deleting the layer form the map and reloading the layer from the feature class.

4. You cannot edit in ArcScene. If you wish to delete feature you can use the Delete Feature tool in the Arc Toolbox to delete features from a layer.
Getting familiar with ArcScene:

Open ArcScene by Selecting Start >Programs > ArcGIS > ArcScene. [image: image30.png]Arcscene.



 Save the ArcScene document as Groundwater.sxd. Load into the scene the DEM (smdemproj) of the San Marcos Basin.  Select the smdemproj layer; open its Properties by Right Clicking > Properties. Select the Base Heights tab, select to obtain heights from a surface and specify the smdemproj layer. 
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Click OK. You can also change the symbology of the smdemproj layer through the properties window.   Due to the large difference between the horizontal and vertical extents of the data it is difficult to see any change in elevation without exaggerating the vertical dimension. Go to View > Scene Properties and change the Vertical Exaggeration to 25. 
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Here is an example of the resulting display.
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The ArcScene “Tools” toolbar looks somewhat like the one in ArcMap, except that it has various tools for zooming into targets.   The most useful tool is the Navigate button [image: image35.png]


 that enables you to manipulate the orientation of the display.   ArcScene has no “Go Back” to the previous extent button like ArcMap has so if you want to get back to the full extent of the scene, you have to use the Full Extent button.   [image: image36.png]


.

Adding a Vector Theme

One of the nice features of ArcScene is that you can “drape” vector themes on raster ones, in other words you can assign an elevation for viewing vector features from a separate surface.  In this case, lets see how our streams look draped on the DEM.   Load the Waterline feature class from the HydroGeology feature dataset.  You’ll see it displayed at 0 elevation, much below the DEM display.   Go to Properties/Base Heights and obtain base heights from surface smdemproj, and include an offset of 20 so that the streams show up just above the DEM surface (without the offset they tend to get merged into the DEM surface).
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To be turned in:  An ArcScene image of the San Marcos DEM with the streams draped over it.

Viewing the Piezometric Head Map.

Add the Piezohead raster to the ArcScene document.   Turn off the DEM display.   Adjust the Base Height of the Piezohead raster to Obtain base heights from Piezohead.    Add the Springs theme from the HydroGeology feature dataset and set its Base Height to be obtained from smdemproj.  You can see a nice association between the piezometric head surface, the stream network and the spring locations.
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Turn on the DEM surface, and adjust its transparency using the 3DEffects toolbar so that you can see the piezometric head surface below the DEM.   

[image: image40.png]



To be turned in: an 3D ArcScene image showing the terrain, streams, piezometric head  surface and springs.

Arc Hydro groundwater toolbar:

In this section you will use the Arc Hydro groundwater tools. First you will need to load the toolbar. The toolbar DLL is available in the DLLs folder; you can also download the DLL from the CRWR website at: http://www.crwr.utexas.edu/gis/gishydro04/index.htm. In this exercise you will get familiar with a number of the tools in the toolbar, for a more detailed description see the CRWR website just referenced. If you have not already done so, Copy the file GroundwaterToolbarNew.dll into C:\Program files\ArcGIS\Bin.   Right click on it and say Register (Silent).   Go to Tools/Customize/Commands, and say Add from file, Navigate to the location of the GroundwaterToolbarNew.dll file and select it. Wait until the following message appears.
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Something called MyCustomTools should show up in the Command window, and if you switch to the Toolbars window, you should see Arc Hydro Groundwater Tools as an option.  Select OK. Activate the Arc Hydro Groundwater Tools. 
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Click Close. The following toolbar should appear in the Scene.
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A few tips regarding the use of the toolbar:

1. Be patient and careful with the tools they are still under development and will crash easily. Some of the tools require some processing time.

2. If you get the following message don’t be intimidated, this is done for debugging purposes. Click OK and close the error log window.
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3. 3D features may not show up and you might need to refresh the layers or reload the layer into the scene to view results.

4. If a tool’s interface is not working try closing the scene and reopening it.

Creating a GeoVolume of the San Marcos river basin

ArcScene allows us to extrude vector objects in the vertical dimension, points become lines, lines become polygons, and polygons become volumes. We will start with extruding the San Marcos basin into the subsurface. Load the SanMarcosBasin feature class from the Hydrogeology feature dataset and set its base height from the DEM. 
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You should be able to view the basin area on top of the DEM.  Open the Properties of the San Marcos Basin layer and select the Extrusion tab. Specify an extrusion value of -500.   
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Click OK. You can now see the basin extruded 500 meters into the surface. Adjust the Transparency of the smdemproj layer and the San Marcos Basin layer using the 3D Effects toolbar and you’ll see that you can achieve a rather nice display of a downward extrusion of the San Marcos basin below the DEM surface.    Now, what we have so far is just a polygon whose appearance has been altered by an extrusion.    What we are now going to build using the Arc Hydro Groundwater tools is a Multipatch feature representation of this volume.  Multipatch is a new feature type that we have not met before in ArcGIS that consists of a collected set of triangular surfaces that when properly constructed can constitute a volume.  
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Load the GeoVolume feature class [image: image48.png]


from the Hydrogeology feature dataset.    The little house symbol [image: image49.png]


 signals that this is a Multipatch feature class (Multipatches are used to represent buildings in ArcScene renderings of urban infrastructure).  If you open the GeoVolume feature class, you’ll see that it has no features created in it as yet. 
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Use the select tool [image: image51.png]


 to select the polygon feature representing the San Marcos basin.  Click on the part that is displayed beneath the DEM so that you can separate the selection of the basin from the DEM.
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In the Arc Hydro Groundwater Tools menu, Select the Extrude between Grid and a Value tool in the 3D Cell Builder menu. This menu contains tools that create volumetric objects from a polygon by different methods of extrusions. The inputs to the tools are polygon features and the outputs are 3D volumes (multipatches).
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In the tool’s window select the GeoVolume Layer as the Cell3D layer, the SanMarcosBasin layer as the Cell2D, the smdemproj as the bottom grid and specify -500 as the top value.
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Click Continue. Click OK in the message box when prompted by the tool that 1 feature is selected.  A 3D volumetric object should appear in the map (If the tool has run and you can’t see the object select the GeoVolume layer, right click and select refresh to redraw the layer in the scene).    You can use the 3D Effects toolbar to change the transparency of the GeoVolume.   Turn off the San Marcos Basin layer and open up the Attributes of GeoVolume Table.  You’ll see that you’ve now created a Multipatch feature that is a kind of control volume for the subsurface representation of the San Marcos Basin.
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To be turned in: An ArcScene image of the San Marcos Basin as a GeoVolume.

Creating BoreLines from Wells:

Load the Well and BoreLine feature classes from the Hydrogeology feature dataset, also load the Hydrostratigraphy table from the exercise geodatabase (the table is not in a feature dataset but in the first level of the geodatabase). As discussed before there are 3 types of wells: Water wells, stratigraphy, and springs. The wells are distinguished by the FType field: 1 for water wells, 2 for stratigraphy, and 3 for springs. You can use the definition query tool in the Arc Hydro Groundwater Tools toolbar to view specific types of wells (this is the same as using the definition query in the properties of the layer). 

In the Table of Contents window select the Well layer, then go to the Definition Query Tool in the groundwater toolbar and view only the stratigraphy wells.   The Definition Query Tool is the window on the right hand side of the toolbar with options available in it via a pull-down menu.  Note that you have to have the Well layer highlighted to see the different types of wells as options in the Definition Query Tool.    If you have another feature class highlighted, you’ll see whatever FType values it has for display instead.
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You are now viewing and interacting with only the stratigraphy wells. Open the attribute table of the well feature class; you should have only wells with FType = stratigraphy and there should be 139 wells in the attribute table. For the Well feature class, use Properties/Base Height, to set the base heights of the Well layer equal to the LSE field in the well feature by using the little calculator [image: image57.png]


 on the right to set the base height expression.
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To obtain the result:
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You will now create BoreLines from the Well features and the stratigraphy table. BoreLines are three dimensional objects that represent the hydrostratigraphy along a drilled well. The stratigraphy table holds the top and bottom elevations observed for each hydrostratigraphic unit. The HydroID of the Well is also stored as a relate item as HydroID in the Hydrostratigraphy table, as shown in the example below. 
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If you open the Attributes of Boreline table, you’ll see that at this point, you don’t have any Borelines. 
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Select the Well layer, Right click > Selection > Select All to select all the well features in the layer. Select the Make BoreLines from Wells command from the Wells and BoreLines menu. 
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Leave all the defaults in the tools interface and select the Hydrostratigraphy table as the vertical measurement table.  
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Click Continue. A set of 3D lines should appear in the scene when the tool is done.  The WellID of the Boreline is the HydroID of the Well from which it was created.   You’ll see that 139 Borelines have been created, one for each well.   Each line represents the penetration of the Edwards Aquifer of the borehole drilled at this well location.
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You can color the BoreLines and make the width larger to better view the results by right clicking on Properties and adjusting the symbology settings. In this example the measurements represent the top and bottom of one hydrostratigraphic unit, the Edwards aquifer. But if desired multiple units can be represented (see the tools’ documentation for more details). 
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To be turned in:  An ArcScene image of the wells and borelines

Creating GeoSections from the BoreLines

You will now create GeoSections from the BoreLines. A GeoSection is a cross section of the geologic stratum to explore and create views of the stratigraphy information. Load the GeoSection feature class from the Hydrogeology feature dataset into the scene. There are initially no GeoSection features in this feature class.
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Activate the BoreLine GeoSection tool. 
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Use the cursor to specify a cross section by selecting a number of wells along the desired section line (it might be easier to see the wells if you unselect the BoreLine layer).
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When you are done defining the section line right click; The following interface should appear.
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Go ahead and select the Create GeoSections command. The tool will prompt you to specify a name for the GeoSection. 
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Click OK. A GeoSection will be created and added to the map.  The GeoSections are polygons where each feature is a vertical polygon drawn between two borelines (for Well1 and Well2).  The example shown below shows 5 polygons drawn between 6 wells.    
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To be turned in:  An ArcScene image of a GeoSection

Creating a GeoVolume from the BoreLines:

Ok, now for our last task, you are going to create a volume object encompassing the Borelines. You will use the Convex Hull from BoreLines tool to generate a GeoVolume. This tool uses the QHull algorithm to compute the convex hull (smallest convex volume that includes a set of points). For more about QHull in the documentation or at: http://www.qhull.org/.

Make sure the GeoVolume feature class from the Hydrogeology feature dataset is still loaded. Select the Options tab in the groundwater toolbar. You will have to specify the location of the input and output files needed for QHull. The files are located in the Q folder of the exercise. Browse to the following files: data1.txt, result1.txt, result2.txt, Qhull1.bat, Qhull2.bat as shown below.
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Click Continue. (Note: You will have to set the file locations every time you reopen the map)

Select all the BoreLines in the layer by Selecting the layer > Right Click >Selection > Select All. Select the Convex Hull from BoreLines tool from the GeoVolume Generation menu. 

[image: image73.png]&k Untitled.sxd - ArcScene - ArcInfo

Elo Edt View Selection Tooks Window Help

DEE&) hEX ¢ Eassnw|s-asaeaa

OER O M

PN o oo

[ Scenc layers
= B Ci\GiGISClassFallz004hew_1003|EX6GW.mdb

O SentercosBasin
O Edwardssouth

00 5prings

& Hydrostratigraphy

5 &8 CHGHGISClassFal2004tien_1003{Rasterst
O smdemproj

O potsurface

I 1

Display_Souce

Feature dass =
& Featwes

7 Add Y Conrdinates

> Check Geametry

2 Copy Features

> DeleteFeatures

> Featue Envelope to Palygon

P Featue ToLne

> Festure Torant

> Featue To Pobygon

> Featue Verties To Ponts

> Mitipart To Snlepart

2 Polygon To Line

> Repai Geometry

> Splt Lne it verices

& Fiolds =

Favortes [Index ] Seaich

Canvex Hul From Borelines

Bsert| | & @ O M 2 2 DEQR & | Hoezordor-.. [ untitledsnd... [ Totel Commn... | &) ahl for conv...| |

| L el

[arc Hydro Groundwater Tools ]

i)

GeoVolume Generation 3D CellBuider ¥ Wels and Borelines ] options 7 N\

Convex Hul From 3D points
Solds from 4L





Specify the multipatch layer as the GeoVolume layer, the BoreLine layer, and area, volume and hydrogeologic unit ID (HGUID) fields as shown below.
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Select Continue. Upon completion the following message should appear.
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The message shows the time and date of completion and the surface area and volume of the calculated GeoVolume. The units of the area and volume are the same as the projection units (in this example meters).  Click OK. The GeoVolume you created should appear in the scene. You can change the transparency of the GeoVolume layer to visualize objects inside the volume.  
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If you open the Attributes of GeoVolume table, you’ll see that you’ve now got two GeoVolume features, the Extrusion of the San Marcos basin that you constructed earlier and the convex hull of the borelines that you just constructed.   The second of these GeoVolumes has a surface area (ConArea) and a volume (ConVolume) associated with it.  You can also see some limitations of this tool – it encloses part of the volume that is outside the Edwards aquifer but within the convex hull of its borelines.   There are other, more accurate ways of created GeoVolumes for aquifers, such as with a specialist tool like the Groundwater Modeling System (GMS).   The Solids from XML tool helps to import into ArcGIS the volume objects created in external modeling systems.
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You can use the GeoVolume/Properties/Definition Query to select just the convex hull of the borelines geovolume for display.
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To be turned in:  An ArcScene image of the GeoVolume created from the borelines.   What is its surface area in square kilometers?  What is its volume in cubic kilometers?

Summary of items to be turned in

1. A geologic map of the Guadalupe basin.  
2. A soil map of the Guadalupe basin  Pick a particular soil map unit and identify the rock type or types which underly it.
3. Aa map showing the piezometric surface together with the spring features.  What is the gradient of the piezometric head surface in the Edwards aquifer from the western end of the aquifer to Comal Springs?
4. An ArcScene image of the San Marcos DEM with the streams draped over it.
5. An ArcScene image showing the terrain, streams, piezometric head  surface and springs.
6. An ArcScene image of the San Marcos Basin as a GeoVolume.
7. An ArcScene image of the Wells and Borelines
8. An ArcScene image of a GeoSection
9. An ArcScene image of the GeoVolume created from the borelines.   What is its surface area in square kilometers?  What is its volume in cubic kilometers?
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